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1: OSNOVE PROGRAMIRANJA

V PYTHONU

3

Prirejeno po e-učbeniku za informatiko v gimnaziji, 2015:

https://lusy.fri.uni-lj.si/ucbenik/book/index.html

https://lusy.fri.uni-lj.si/ucbenik/book/index.html


OSNOVNI KONCEPTI PROGRAMIRANJA

4



NAMESTITEV PYTHONA VER. 3

5

 Python3 na OS Windows namestimo tako, da na naslovu

https://www.python.org/downloads/windows/ izberemo

najnovejši namestitveni paket (trenutno 3.12.2), poženemo

namestitev ter sledimo navodilom

 Na voljo so tudi paketi za druge operacijske sisteme –

MacOS, Linux/UNIX, itd.

 Po namestitvi zaženemo Pythonov interaktivni tolmač

IDLE (Integrated DeveLopment Environment) oziroma

njegovo lupino (shell)

 Spletna pomoč za Python3: dokumentacija na

https://docs.python.org/3/

 Python2 in Python3 se med seboj precej razlikujeta, zato

odsvetujemo uporabo Pythona ver. 2 !

https://www.python.org/downloads/windows/
https://docs.python.org/3/


UPORABA INTERAKTIVNEGA TOLMAČA

6

IDLE: interaktivni 

tolmač (lupina, shell)

Spisek bližnjic: Options > 

Configure IDLE > Keys



VRSTNI RED IZVAJANJA OPERACIJ
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IZRAZ, SPREMENLJIVKA, PRIREDITEV
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IZRAZ, SPREMENLJIVKA, PRIREDITEV (NAD.)

9



PRIREDITVENI STAVEK
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ŠTEVILSKA PODATKOVNA TIPA
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type(a) = int

type(b) = float



ŠTEVILSKA PODATKOVNA TIPA (NAD.)
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Podatkovni tipi v Pythonu

Integer Float Complex

Boolean



ZNAKOVNI PODATKOVNI TIP
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type(dejstvo) = str



ZNAKOVNI PODATKOVNI TIP (NAD.)
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2: IZDELAVA SAMOSTOJNIH

PROGRAMOV IN POGOJNI

STAVKI

15



PROGRAM IN POGOJNI STAVKI
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OD ZAPOREDJA STAVKOV DO PROGRAMA

17

hitrost.py



OD ZAPOREDJA STAVKOV DO PROGRAMA
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Tolmač: File > New File

urejevalnik 

(editor)

*

*



PROGRAM, ZAPISAN V DATOTEKI

19

Urejevalnik: File > Save As ...* *

** **
(tipka Start)

Vtipkaš cmd

nato pritisneš tipko Enter

terminal 

(konzola)

Shranjeni program, 

napisan v urejevalniku, 

lahko poženemo tudi kar 

v interaktivnem tolmaču 

(urejevalnik: Run > Run 

Module; bližnjica: F5) 



VHOD IN IZHOD

20



VHOD IN IZHOD (NAD.)
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VHOD IN IZHOD (NAD.)

22

Python nam rezultat izpiše na veliko 

preveč decimalk natančno, a se s tem 

problemom ne bomo ukvarjali. 

Pomembneje je, da se naš program zna 

"pogovarjati" z uporabnikom: 

uporabnik programu poda vhod, 

program pa mu izpiše svoj izhod. V 

splošnem je vhod v program množica 

podatkov, ki jih program prejme. Vhod 

lahko — tako kot v našem primeru — 

vnese uporabnik, lahko pa ga program 

pridobi iz datoteke ali z interneta ali 

pa mu ga posreduje nek drug program. 

Izhod pa je skupno ime za vse podatke, 

ki jih program proizvede pri danem 

vhodu. V našem primeru smo izhod 

izpisali na zaslon, lahko pa ga program 

tudi zapiše v datoteko ali posreduje 

nekemu drugemu programu.

hitrost.py



IZPIS (FUNKCIJA PRINT)

23

Python nam ne pusti 

združevanja nizov in števil z 

operatorjem + . Ta operator 

lahko uporabimo bodisi za 

seštevanje števil ali pa za 

združevanje (lepljenje) nizov. Če 

želimo niz sestaviti na podlagi 

vrednosti različnih tipov, 

moramo vse vrednosti, ki niso 

nizi, s pomočjo operatorja str 

pretvoriti v nize – torej 

uporabiti: str(b), str(k) in str(a)!

!!!



POGOJNI STAVEK

24

*

*



POGOJNI STAVEK (NAD.)
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bazen.py



POGOJNI STAVEK (NAD.)
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POGOJNI STAVEK (NAD.)

27

bazen.py



LOGIČNI IZRAZI
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type(a) = bool



LOGIČNI IZRAZI (NAD.)

29

Tabela logičnih operatorjev



HROŠČI IN RAZHROŠČEVANJE

30

Tolmač: Debug > Debugger



3: ZANKE

31



ZANKE

32



ZANKA WHILE

33



ZANKA WHILE (NAD.)
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ZANKA WHILE (NAD.)

35

sahovnica.py



ZANKA FOR
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ZANKA FOR (NAD.)

37

povprecje_ocen.py



ZANKE - NAPREDNO
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 Gnezdenje zank

 Predčasni izhod iz zanke

 stavek break

 Skok na konec trenutne iteracije

 stavek continue

→ Glej e-učbenik:

https://lusy.fri.uni-lj.si/ucbenik/book/1203/index5.html

https://lusy.fri.uni-lj.si/ucbenik/book/1203/index5.html


4: TABELE (= SEZNAMI)
39

Seznam je interno shranjen kot tabela kazalcev na objekte (elemente), a v praksi se za ta 

podatkovni tip skoraj vedno uporablja ime 'seznam' (angl.: list)!



TABELE

40



TABELA

41
type(prodaja) = list



DOSTOP DO ELEMENTOV TABELE

42



ODSEK TABELE

43



SPREHOD PO ELEMENTIH TABELE

44

prodaja.py



SPREHOD PO ELEMENTIH TABELE (NAD.)
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prodaja.py



SPREHOD PO INDEKSIH TABELE

46

prodaja.py



SPREMINJANJE, DODAJANJE IN ODSTRANJEVANJE

ELEMENTOV

47

objektno programiranje 

(OP) – na objektu 

uporabimo metodo:

objekt.metoda

Pomoč glede metod na 

objektih: 

- v Pythonu: vtipkaš 

dir(list) 

- na spletu: Google > 

"python3 list methods" 

(podobno glede iskanja 

metod za ostale 

Pythonove strukture)



SPREMINJANJE, DODAJANJE IN ODSTRANJEVANJE

ELEMENTOV (NAD.)

48



5: FUNKCIJE

49



FUNKCIJE

50



FUNKCIJA

51



FUNKCIJA (NAD.)

52



ENOSTAVEN PRIMER

53

Funkcijo napišemo v 

urejevalniku, shranimo v 

datoteko enost_funk.py  

(CTRL + s) in jo po ukazu 

Run > Run Module (F5) 

lahko uporabljamo – 

kličemo – kar iz tolmača



MALO VEČJI PRIMER

54

skrajšan zapis za:

vsota = vsota + meritve[d] 

Ta del je 

smiselno zapisati 

kot novo funkcijo 

Izpisi()

Program za branje 

zaporedja n meritev



MALO VEČJI PRIMER (NAD.)

55

kompl_funk1.py



PARAMETRI

56

kompl_funk2.py



FUNKCIJE - NAPREDNO

57

 Lokalne vs. globalne spremenljivke

https://lusy.fri.uni-lj.si/ucbenik/book/1205/index6.html

 Vračanje rezultata iz funkcije

https://lusy.fri.uni-lj.si/ucbenik/book/1205/index7.html

 Gnezdenje klicev in rekurzivne funkcije

https://lusy.fri.uni-lj.si/ucbenik/book/1205/index9.html

 Funkcije in strukturirano programiranje

https://lusy.fri.uni-lj.si/ucbenik/book/1205/index11.html

https://lusy.fri.uni-lj.si/ucbenik/book/1205/index6.html
https://lusy.fri.uni-lj.si/ucbenik/book/1205/index7.html
https://lusy.fri.uni-lj.si/ucbenik/book/1205/index9.html
https://lusy.fri.uni-lj.si/ucbenik/book/1205/index11.html


NEKAJ STANDARDNIH FUNKCIJ

58

Vsak programski jezik ima tudi nekakšno standardno knjižnico funkcij (angl.: libraries), ki so 

že del jezika in jih lahko uporabljamo, ne da bi jih morali napisati sami. Poleg že videnih 

funkcij kot sta input in print, je tule še nekaj Pythonovih funkcij, ki pogosto pridejo prav:



6: NIZI
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NIZI

60



NIZ

61



NIZ (NAD.)

62



NIZ (NAD.)

63

trik_piram_funk.py



PODNIZ

64

podniz_funk.py



ZNAKI IN UREJENOST NIZOV

65



OPERACIJE NA NIZIH – ISKANJE PODNIZOV

66

Spet gre za objektno 

programiranje (glej 

poglavje Tabele):

objekt.metoda



OPERACIJE NA NIZIH – PREVERJANJE ZNAKOV

67



OPERACIJE NA NIZIH – PREVERJANJE ZNAKOV (NAD.)
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OPERACIJE NA NIZIH – ZAMENJAVE PODNIZOV

69



7: RAZNO – N-TERICE, 

SLOVARJI IN MODULI

70



ELEMENTI MNOŽICE: N-TERICE

71

type(a) = tuple



SLOVAR

72

type(h) = dict



OPERACIJE NAD SLOVARJEM
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OPERACIJE NAD SLOVARJEM (NAD.)
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PYTHONOV MODUL

75

Trije moduli v okviru 

standardne knjižnice 

(Standard Library; glej 

Global Module Index v 

Pythonovi dokumentaciji):  

random, math, turtle



PYTHON V PRAKSI –

PRIMERI APLIKACIJ

76



8: GENERATIVNA UMETNOST IN

RAČUNALNIŠKE IGRE

77



RAČUNALNIŠKA UMETNOST

78

 Nekaj primerov:

 http://blog.wispeo.com/featured-creative/glenn-marshall-creating-art-from-

the-python-language/

 https://labs.ideo.com/2014/06/04/painting-with-code/

 Za profesionalno (odprtokodno) delo se uporablja program Processing …

 https://processing.org/

 Možno je tudi programiranje v Pythonu – Processing.py:

http://py.processing.org/

 … ali pa Pygame – računalniške igre, umetnost, multimedijski projekti:

 http://pygame.org/hifi.html

http://blog.wispeo.com/featured-creative/glenn-marshall-creating-art-from-the-python-language
http://blog.wispeo.com/featured-creative/glenn-marshall-creating-art-from-the-python-language
https://labs.ideo.com/2014/06/04/painting-with-code/
https://processing.org/
http://py.processing.org/
http://pygame.org/hifi.html


PYTHONOV MODUL TURTLE

 Omogoča enostavno izdelavo kompleksnih oblik in slik

 https://michael0x2a.com/blog/turtle-examples

 Python IDLE > Help > Turtle Demo

http://codegolf.stackexchange.com/questions/3

6374/redraw-an-image-with-just-one-closed-

curve

http://www.instructables.com/id/Ea

sy-Designs-Turtle-Graphics-

Python/

http://python3.codes/extensible-

harmonograph/

Python 3.5.2 Shell > Help > Turtle Demo

genumet1.py, genumet2.py, genumet3.py 

https://michael0x2a.com/blog/turtle-examples


IZBOR METOD MODULA TURTLE

80

http://interactivepython.org/runestone/static/

IntroPythonTurtles/Summary/summary.html

 Spisek vseh metod:

 https://docs.python.org/2/library/turtle.html

http://interactivepython.org/runestone/static/IntroPythonTurtles/Summary/summary.html
http://interactivepython.org/runestone/static/IntroPythonTurtles/Summary/summary.html
https://docs.python.org/2/library/turtle.html#turtle.color


9: OBDELAVA IN VIZUALIZACIJA

PODATKOV

81



 'Data Science' knjižnice

 NumPy – znanstveni izračuni, delo z matrikami (Arrays)

 SciPy – temelji na NumPy; linearna algebra, optimizacija, statistika

 Pandas – 1- in 2-dimenzionalne podatkovne strukture (Data Frames)

 Strojno učenje

 scikit-learn – klasifikacija, regresija, razvrščanje v skupine, redukcija

dimenzionalnosti, modeliranje

 TensorFlow

 Keras

 PyTorch

 Obdelava slike

 scikit-image

 Pillow – osnovne funkcije

 OpenCV – napredno slikovno procesiranje, računalniški vid

PODATKOVNA ZNANOST IN OBDELAVA PODATKOV

82

globoko 

učenje

https://numpy.org/
https://scipy.org/
https://pandas.pydata.org/
https://scikit-learn.org/stable/
https://www.tensorflow.org/
https://keras.io/
https://pytorch.org/
https://scikit-image.org/
https://pillow.readthedocs.io/en/stable/
https://docs.opencv.org/4.x/d6/d00/tutorial_py_root.html


VIZUALIZACIJA PODATKOV

83The Python ecosystem for Data Science: A guided tour - Christian Staudt

https://www.youtube.com/watch?v=EBgUiuFXE3E

 Matplotlib

 Bokeh

 Seaborn

 Plotly

 ggplot2

https://www.youtube.com/watch?v=EBgUiuFXE3E
https://matplotlib.org/
https://bokeh.org/
https://seaborn.pydata.org/
https://plotly.com/python/
https://ggplot2.tidyverse.org/index.html


PAKETI / KNJIŽNICE

84

 Temeljno orodje je knjižnica Matplotlib. Nanjo se naslanja več drugih knjižnic

za vizualizacijo, med drugim Pandas, Seaborn in ggplot, nekatere druge pa

omogočajo enostavno pretvorbo vizualizacij iz Matplotlib, npr. Bokeh in Plotly,

ki vizualizacijam dodata visoko raven interaktivnosti, ki jo omogoča tudi Pygal.

Vsako od omenjenih orodij ima svoje značilnosti. Tako je v Pandas poudarek na

upravljanju s podatki, zato ga uporabljamo v kombinaciji s skoraj vsemi ostalimi

knjižnicami. Druga pogosto uporabljena knjižnica je Numpy s funkcijami za

numerično računstvo, npr. za generiranje podatkov, in z matematičnimi

funkcijami. Knjižnica Seaborn se uporablja za vizualizacije statističnih obdelav.

Dodatna orodja združljiva z Matplotlib omogočajo izdelavo 3D grafov (modul

Mplot3d), prikaz podatkov na zemljevidih (modul Basemap in knjižnica

Cartopy) in vključevanje interaktivnih gradnikov (v Pythonu modul widgets

knjižnice Matplotlib, v Ipythonu knjižnica Ipywidgets). Visoko interaktivno

orodje za prikaz geografskih podatkov je Folium. Knjižnico Bokeh lahko v

strežniškem načinu dela uporabljamo za upravljanje in vizualizacijo velikih

količin podatkov (big data). To orodje vsebuje možnost vključitve geografskih

podatkov. Posebni knjižnici za numerično obdelavo slik sta Scipy in orodjarna

Scikit-image, za nekatere osnovne operacije nad slikami pa uporabimo Numpy.

Vizualizacije prikažemo na zaslon, lahko pa jih shranimo v slikovne datoteke

(navadno v png format) ali celo v html format (v Bokeh).



MATPLOTLIB

85

http://matplotlib.org/



NUMPY, PANDAS

86

http://www.numpy.org/

http://pandas.pydata.org/



ANACONDA

87

 Anaconda je ena od Pythonovih distribucij in vsebuje več kot 100
najrazličnejših paketov (= knjižnic in modulov) za obdelavo podatkov v
Pythonu – vključno z večino paketov za vizualizacijo

 Namestitev: https://www.anaconda.com/download

 Ob namestitvi so nam na voljo tudi različni vmesniki za delo s Pythonom …

 … mi bomo v nadaljevanju uporabljali orodje Spyder (Scientific PYthon
Development EnviRonment)

https://www.anaconda.com/download


SPYDER
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interaktivni tolmač 

(console, shell)

urejevalnik

raziskovalec



IZDELAVA ENOSTAVNEGA DIAGRAMA

89

 Uvozimo/naložimo paketa pandas in matplotlib.pyplot in

ju poimenujemo kot pd in plt :

>>> import pandas as pd

>>> import matplotlib.pyplot as plt

 Preberemo podatke iz Excelove datoteke 'podatki1.xlsx' na

disku in jih naložimo (uvozimo) v podatkovno strukturo

tipa DataFrame v spremenljivko tabela:

>>> tabela = pd.read_excel('podatki1.xlsx') *

>>> tabela

* Funkcije za uvoz surovih (npr. CSV) podatkov: pd.read_csv, numpy.loadtxt, numpy.genfromtext



IZDELAVA ENOSTAVNEGA DIAGRAMA (NAD.)
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 Sedaj lahko podatke filtriramo, obdelujemo, analiziramo,

npr.:

>>> tabela_filt = tabela[tabela['x'] > 0.3]

>>> tabela_filt

>>> y_povp = tabela_filt['y'].mean()

>>> y_povp

2.621198418600945

Tabela vsebuje le tiste 

vrstice, pri katerih je 

izpolnjen pogoj x > 0.3

Izpis povprečja vseh 

šestih vrednosti 

stolpca y



IZDELAVA ENOSTAVNEGA DIAGRAMA (NAD.)

91

 Ker gre za daljši niz Pythonovih ukazov, jih je smiselno
napisati v urejevalniku, shraniti v datoteko in pognati
(Run > Run; bližnjica F5) v interaktivnem tolmaču:

 Razpršeni diagram 'Spremenljivka 1' vs. 'Spremenljivka 2' 
se prikaže v oknu Raziskovalca (zavihek 'Plots‘)

enost_diag.py



ANALIZA IN VIZUALIZACIJA VEČJE TABELE

92

 Kompleksnejši primer vizualizacije ("Big Data"):
 https://realpython.com/blog/python/working-with-large-excel-files-in-pandas/

 Analizirali bomo manjšo podatkovno tabelo 'Road Safety Data-Accidents 2022-

Provisional Mid Year Unvalidated Data’, pridobljene s spletne strani

https://www.data.gov.uk/dataset/cb7ae6f0-4be6-4935-9277-47e5ce24a11f/road-safety-

data:

https://data.dft.gov.uk/road-accidents-safety-data/dft-road-casualty-statistics-accident-

provisional-mid-year-unvalidated-2022.csv

nesrece2022.py

https://realpython.com/blog/python/working-with-large-excel-files-in-pandas/
https://www.data.gov.uk/dataset/cb7ae6f0-4be6-4935-9277-47e5ce24a11f/road-safety-data
https://www.data.gov.uk/dataset/cb7ae6f0-4be6-4935-9277-47e5ce24a11f/road-safety-data
https://data.dft.gov.uk/road-accidents-safety-data/dft-road-casualty-statistics-accident-provisional-mid-year-unvalidated-2022.csv
https://data.dft.gov.uk/road-accidents-safety-data/dft-road-casualty-statistics-accident-provisional-mid-year-unvalidated-2022.csv


10: LUŠČENJE SPLETNIH

PODATKOV (HTML PARSING, 

WEB SCRAPING)
93



SPLETNO LUŠČENJE PODATKOV

94

 Podatki na spletnih straneh so dostikrat na voljo v

uporabniku prijazni obliki (PDF, XLS(X), CSV…)

 Včasih pa so informacije, ki nas zanimajo, razpršene po

večjem številu spletnih strani, vsebujejo

nepomembne/moteče podatke, se pogosto spreminjajo, ipd.

 V teh primerih lahko uporabimo različna orodja za "Web

scraping"

 Tudi s Pythonom lahko učinkovito iščemo po spletnih

straneh in ekstrahiramo relevantne podatke

 Najprej ponovimo, kako delujeta internet in splet!



INTERNETNI SKLAD PROTOKOLOV

95

 Štirinivojska arhitektura

(TCP/IP model)

By en:User:Kbrose - Prior Wikipedia artwork by en:User:Cburnett, CC BY-SA 3.0, 

https://commons.wikimedia.org/w/index.php?curid=1831900

Aplikacijski nivo: HTTP, FTP, SMTP …  

Transportni nivo: TCP, UDP … 

Omrežni nivo: IP

Povezovalni nivo: 

Ethernet, Wi-Fi …



SPLETNI PROTOKOL: HTTP

96

 HTTP: osnovni 

aplikacijski protokol 

razvit za dostopanje do 

spletnih vsebin

 Osnovni princip: 

1. Poveži se s strežnikom

2. Pošlji zahtevek 

(request)

3. Pridobi dokument(e)

4. Zapri povezavo s 

strežnikom

http://www.thegeekstuff.com/2011/11/tcp-ip-fundamentals



KAJ DELA SPLETNI BRSKALNIK?

97

 Vsakič, ko uporabnik klikne na hiperpovezavo, da bi prišel

na novo spletno stran, brskalnik vzpostavi povezavo s

spletnim strežnikom in izda "GET" zahtevo (= request) s

ciljem pridobiti vsebino strani z določenega spletnega

naslova (URL-ja)

 Strežnik vrne (= response) HTML dokument brskalniku, ki

ga oblikuje in prikaže uporabniku

 Namesto brskalnika pa lahko za pridobivanje in prikaz

podatkov z oddaljenega strežnika uporabimo tudi druge

načine

 Telnet (nas ne zanima ☺ )

 Python



 Prvi način: 10 vrstic kode

 Drugi način: 3 vrstice kode (!!!)

PYTHON KOT SPLETNI BRSKALNIK

98
 Kdo sploh še potrebuje 

spletni brskalnik ☺

Tekstovna, ne HTML 

datoteka !

splet_podatki1.py



ORODJA IN OPOZORILO

99

 Requests (za pridobivanje spletnega dokumenta)

 https://requests.readthedocs.io/en/master/#

 BeautifulSoup4 (za ekstrakcijo oz. razčlenjevanje (parsing)

posameznih delov dokumenta)

 https://www.crummy.com/software/BeautifulSoup/

 RegEx (napredno…)

 https://docs.python.org/3.6/library/re.html

 Pri spletnem luščenju moramo biti previdni!

 Legalni problemi (tožbe, sodni pregoni)

 Če je na voljo API, ga uporabljajmo!

 Slabo napisana HTML (CSS, JavaScript, XML…) koda ovira

uspešno pridobivanje spletnih podatkov

https://requests.readthedocs.io/en/master/
https://www.crummy.com/software/BeautifulSoup/
https://docs.python.org/3.6/library/re.html
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 Web Scraping 101 – Introduction

 https://www.youtube.com/watch?v=6UkI-

VF6h0k&list=PLozj871qTroOuALRdOGF5cUBol5ov7fNN

splet_podatki2.py

PRIMER ŠT. 2

 Scrape Websites with Python + Beautiful Soup 4 +

Requests -- Coding with Python

 https://www.youtube.com/watch?v=3xQTJi2tqgk&list=PLozj871

qTroOuALRdOGF5cUBol5ov7fNN&index=2

splet_podatki3.py

https://www.youtube.com/watch?v=6UkI-VF6h0k&list=PLozj871qTroOuALRdOGF5cUBol5ov7fNN
https://www.youtube.com/watch?v=6UkI-VF6h0k&list=PLozj871qTroOuALRdOGF5cUBol5ov7fNN
https://www.youtube.com/watch?v=3xQTJi2tqgk&list=PLozj871qTroOuALRdOGF5cUBol5ov7fNN&index=2
https://www.youtube.com/watch?v=3xQTJi2tqgk&list=PLozj871qTroOuALRdOGF5cUBol5ov7fNN&index=2
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• Skupaj s še dvema sošolcema si izberite projekt*, pri katerem 

boste uporabili vsaj tri Pythonove knjižnice (npr. Numpy, 

Pandas in MatplotLib)

• Namestite (install) potrebne pakete/knjižnice/module – 

uporabite distribucijo Anaconda in/ali opcijo pip install – da jih 

boste lahko uvozili (import) in uporabili v svoji skripti

• Napišite program (kodo), v katerem boste implementirali 

posamezne korake projekta

• V seminarski nalogi in predstavitvi jih prikažite – pojasnite dele 

kode in predstavite rezultate v obliki diagramov, tabel, 

vizualizacij…

* Lahko si pomagate s kakim že izdelanim, ki je na voljo na spletu – 

v tem primeru v seminarski nalogi obvezno navedite njegov URL 

naslov! – a ga čim bolj priredite v skladu z vašimi preferencami in 

znanjem programiranja. Naj bo projekt v čim večji meri vaše 

avtorsko delo!

https://www.anaconda.com/products/distribution
https://www.listendata.com/2019/04/install-python-package.html
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• Prosto dostopne podatkovne zbirke

• Kaggle: https://www.kaggle.com/datasets

• Več možnosti: https://careerfoundry.com/en/blog/data-

analytics/where-to-find-free-datasets/

• Problem trgovskega potnika: 

https://towardsdatascience.com/solving-travelling-

salesperson-problems-with-python-5de7e883d847

• Detekcija barv s pomočjo knjižnic Pandas & OpenCV: 

https://data-flair.training/blogs/project-in-python-colour-

detection/

• Python za oblikovalce (samo za MacOS !): 

https://pythonfordesigners.com/

https://www.kaggle.com/datasets
https://careerfoundry.com/en/blog/data-analytics/where-to-find-free-datasets/
https://careerfoundry.com/en/blog/data-analytics/where-to-find-free-datasets/
https://towardsdatascience.com/solving-travelling-salesperson-problems-with-python-5de7e883d847
https://towardsdatascience.com/solving-travelling-salesperson-problems-with-python-5de7e883d847
https://data-flair.training/blogs/project-in-python-colour-detection/
https://data-flair.training/blogs/project-in-python-colour-detection/
https://pythonfordesigners.com/
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 G. Anželj in sod.: Računalništvo in informatika 1 – E-učbenik za

informatiko v gimnaziji, 2017. Splet: http://lusy.fri.uni-
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http://lusy.fri.uni-lj.si/ucbenik/
http://lusy.fri.uni-lj.si/ucbenik/
https://docs.python.org/3/
https://www.sololearn.com/Play/Python
http://goo.gl/PK1rUZ
https://wiki.python.org/moin/BeginnersGuide
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